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Thank you for your interest in the Synthesis Platform. This guide demonstrates some of the opportunities 
for integration between Synthesis applications.

We will ask you to imagine that you are designing and building a new product, then discuss the steps you 
might take in the various Synthesis applications. Please note that the sample data sets provided are 
fictional and intended for demonstration purposes. Furthermore, note that this guide shows only some of 
the many analysis and integration capabilities in the Synthesis Platform. Within each application, you can 
choose File > Help to access a wide array of resources that will help you explore other software 
capabilities.

This guide is intended to show a possible workflow that is enabled by the integration among the Synthesis 
applications. For this reason, step-by-step instructions are not provided for most of the tasks; instead, a 
higher-level discussion is given. The guide will refer to sample projects in the example database that is 
installed with the software (called “Synthesis10_Guide_Rev1.rsgz10”) to allow you to view the relevant 
parts of the analysis. To access the file, choose File > Help in any Synthesis desktop application, click 
Open Examples Folder, then browse for the file in the Synthesis sub-folder.

The Synthesis Platform 
Guide 1
The Synthesis Platform Guide 1

Tip: To preserve the integrity of the shipped example files, the software creates a copy of the file each time you 

access a repository  in the Examples folder. The copy has the same name as the original file and  is saved  in the 
default documents folder for your computer (e.g., My Documents\ReliaSoft\Files). Use the copy to work on the 
example projects and save your changes. Any changes you make in the copy will not affect the original file.



1  The Synthesis Platform Guide

At various times, you will need to open the sample projects in different Synthesis applications. These 
transitions are marked in the guide with the application’s icon. The simplest way to open the current 
project in another Synthesis application is to click the Another Synthesis Application icon in the Quick 
Access Toolbar at the top of the window, and choose the application from the list.

Also note that many of the steps in this guide can be performed in Xfmea, RCM++ or RBI. All 
screenshots for these steps show the RCM++ interface, so if you are working in Xfmea or RBI, your 
interface may look slightly different from what is shown in the guide.

If you have not purchased licenses for all of the applications used in this guide, you can activate free, 
expiring demos of the unlicensed applications via the Synthesis installation.

IMPORTANT: Note that  it may sometimes be necessary to modify the data  in the quick start repository to fit 

updated instructions or new examples in the latest printing of this quick start guide. This printing of the guide was 
designed for use with Synthesis10_Guide_Rev1.rsgz10 (where _RevX indicates the database revision). If you try 
to use a different database revision,  the sample projects may not exactly match the  instructions printed here. 
1) If this guide is older than the latest database revision installed on your computer, you can choose File > Help > 
Quick Start Guide  to download  the  latest printing. 2)  If  this guide  is newer  than  the  latest database  revision 
installed on your  computer, you  can  choose File > Help > Check  for Update  to download  the  latest  software 
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The Synthesis Platform is intended to facilitate data sharing between different reliability engineering 
activities, so that the information produced by an analysis performed in one application is available for use 
in others. As a very simple example, let’s say you have a data set from testing Component A. You use 
Weibull++ to analyze the data set. Then another engineer (let’s call her Karen) wants to analyze the 
reliability and maintainability of a system that incorporates Component A. It makes sense for Karen to use 
the results from your life data analysis in the reliability block diagram (RBD) that she builds in BlockSim.

Sharing Information via 
Synthesis Resources 2
The Synthesis Platform Guide 3



2  Sharing Information via Synthesis Resources

The Synthesis Platform achieves this sort of integration via a concept pioneered by ReliaSoft, called 
object-based reliability modeling (OBRM). The objects, called Synthesis resources, encapsulate 
information in ways that make it easy to share between Synthesis applications, while shielding the 
underlying details from view when they’re not needed.

OBRM does not require the recipient to possess a subject matter expertise in the activity that is providing 
the information. That is, it hides activity-specific complexity and presents the information in a way that 
can easily be used in other contexts. Going back to our simple example: When Karen needs to use 
Component A’s reliability information in her BlockSim RBD, she doesn’t need to see the underlying data 
set. She just wants to be able to use the results of the Weibull++ analysis to describe the component’s 
reliability. 

At the same time, if the underlying data changes, it is important to be able to update the information 
everywhere that it’s used. Let’s say you discover an error in your Weibull++ data set. When you reanalyze 
the data, you need to make sure that the corrected result is used when Karen resimulates the BlockSim 
RBD. 

The Synthesis resource used for the reliability information in our example is called a model. Once you 
have analyzed the data set in Weibull++, you can publish the results as a model.
4 The Synthesis Platform Guide
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Karen can then associate that model with the block representing Component A in the BlockSim RBD.

When you update and reanalyze the Weibull++ data set, you simply republish the model, and the new 
results are automatically used the next time Karen simulates the RBD.

There are several types of Synthesis resources, each used to share a specific kind of information. In this 
guide, you will encounter the following types:

 Universal reliability definitions (URDs) are used to gather together all of the reliability and 
maintenance characteristics for a particular component or assembly. This can include reliability 
models as well as corrective and/or scheduled maintenance tasks.

 Models can represent probabilities, durations or costs. Any of these values can be either fixed 
(constant) or time-dependent. Models are used in a variety of ways — to represent an item’s 
reliability, the duration of a task, the costs associated with a crew, etc. They can be created 
manually or published from analyses in a variety of Synthesis applications.
The Synthesis Platform Guide 5

 Tasks represent maintenance activities. There are two basic kinds of tasks: Corrective tasks are 
unplanned maintenance activities that are performed when a failure occurs and is discovered. 
Scheduled tasks include preventive maintenance activities, inspections and on condition 
maintenance activities.

 Crews represent the labor personnel who will perform the maintenance activity, including the 
availability of the personnel and the time and costs associated with the labor.

 Spare part pools are used to describe the conditions that determine whether a spare part will 
be available when needed for a particular maintenance activity, and to specify the time and 
costs associated with obtaining the spare part.



2  Sharing Information via Synthesis Resources

Each application provides the tools you need to create or use Synthesis resources when applicable. For 
example, you can quickly and easily publish a model from an analyzed data set using the Publishing page 
in a Weibull++, ALTA or RGA folio’s control panel. 
6 The Synthesis Platform Guide



2  Sharing Information via Synthesis Resources

Likewise, the Block Properties window in BlockSim and the Reliability Policy node in Xfmea/RCM++/
RBI make it easy to select existing URDs/models or create them on the fly.
The Synthesis Platform Guide 7



2  Sharing Information via Synthesis Resources

In addition, all of these applications provide access to the Resource Manager (Project > Synthesis > 
Resource Manager), where you can view and manage all of the resources available for the current project 
in the current application.

By default, resources are available for use in all analyses in the project (e.g., a model published from an 
analysis in ALTA can be applied to an FMEA cause in Xfmea, an event in a BlockSim fault tree, and so 
on). You also have the option to make some resources “global” so they are available for use in different 
projects throughout the entire database, as shown for the Component D model in the image above. Notice 
the icon to the left of the model’s name, indicating that it is a global resource.
8 The Synthesis Platform Guide



The best way to illustrate how the Synthesis applications can 
be used together is by looking at an example. This specific 
example is based on a Design for Reliability (DFR) 
approach.

You are forming a new company, Chandeliers-R-Us. For 
your first product, you are designing and building a single-
light pendant chandelier. You intend to sell this chandelier 
for use in residential settings in the United States. 

Because this is a new product and the first development 
project within the organization, neither knowledge nor data yet exist regarding the reliability of the 
proposed product or any of its components.

The following sections describe some of the reliability activities that your team will perform during 
product development, and they demonstrate how the Synthesis Platform facilitates and coordinates these 
activities.

Using the Synthesis 
Platform 3
The Synthesis Platform Guide 9



3  Using the Synthesis Platform

3.1  Create the Project Plan

The DFR process involves a series of logical stages that take you from the concept phase through design, 
development and testing, manufacturing and support. 

Your first task is to create a new project in a Synthesis repository to store all of the information and 
analyses that your team will compile/perform for the new single-light pendant chandelier.

In this section, you will work with the “1. Chandelier ‐ Preliminary Work” project in the quick 

start repository, using Xfmea, RCM++ or RBI.
10 The Synthesis Platform Guide

You create the project in Xfmea/RCM++/RBI and set the project properties. (To view the properties for 
the sample project that has already been created, choose Project > Management > Edit Project 
Properties.) For the FMEA Structure, you choose Grouped Effects and Causes. With this setting, all 
cause and effect records in the FMEAs will be displayed at the same level of the hierarchy under the 
failure mode that they are both associated with. For the configurable settings (e.g., the questions that will 



3.1  Create the Project Plan

be used for risk discovery analysis, the rating scales used to calculate Risk Priority Numbers, etc.), you 
use the predefined RS DFR Focus profile that is installed with the software.

The next task is to create the first item in the System Hierarchy and start defining its characteristics in the 
Properties tab of the Analysis panel, as shown next.
The Synthesis Platform Guide 11

Then you add a project plan for this item. The Project Planner allows you to define gates and sub-gates to 
track and manage the steps in your process plan. It also allows you to incorporate actions (either from the 
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FMEA or defined separately) that are assigned to specific individuals. This allows you to monitor the 
progress of all reliability activities as they relate to the project. You can create a plan from scratch or use 
one of the templates as a starting point, and can update the plan using any Synthesis desktop application 
except MPC. This particular project follows a DFR process, so you will base the plan on the “Project 
Planner Template2 - Basic Plan” template, which you can import from the 
Project_Planner_Templates_Rev1.rsr10 example file that is shipped with the software. You then adapt the 
plan to fit your team's specific needs for this project. 

To see how your team’s plan for the chandelier looks after the first few gates have been completed, open 
the Project Planner (Project > Management > Project Planner) in the sample project. You will notice 
that certain properties of higher-level gates (e.g., the status and due date) are determined by the properties 
of their dependent gates and/or actions. For example, the “Define Reliability Objectives” gate was 
automatically marked as complete when both of its dependents were completed. In this way, the tool 
monitors how the progress of individual activities relates to the completion of the entire process. 

Note: To ensure that you will be able to see some of the “status” functionality that is built into the software, this 

example uses a date that is far in the future. By using a future date, the statuses for incomplete gates/actions show 
as “Not Started” (rather than “Overdue”), which is more likely to appear in a new plan.
12 The Synthesis Platform Guide



3.2  Gather Existing Data/Knowledge

3.2  Gather Existing Data/Knowledge

In this section, you will continue working with the “1. Chandelier ‐ Preliminary Work” project in 

the quick start repository, using Xfmea/RCM++/RBI.
The Synthesis Platform Guide 13

The next gate in the project plan is to gather (or at least identify) the information that you will need for 
subsequent activities. This would include information such as use stress conditions, competing products, 
material properties, etc. If similar designs exist, FRACAS data regarding observed failure modes, 
occurrence rates, etc. are also invaluable.

You can attach the information that you gather to the project plan, either by linking to web pages or files, 
or by storing a copy of the file in the database. For the chandelier, your team attaches four items to the 



3  Using the Synthesis Platform

“Gather Existing Data/Knowledge” gate in the planner. They are accessible by clicking the Attachments
icon in the Gate Properties window, as shown next.

3.3  Identify the Use Conditions

Establishing the limits on the environmental and use conditions is one of the most important elements of 
the DFR process. In the case of the chandelier, this is fairly simple, as the product is intended for use in 
residential settings in North America. Based on the knowledge gathered for the “Gather Existing Data/
Knowledge” gate, you return to the Properties tab for the chandelier and enter the environmental 

In this section, you will continue working with the “1. Chandelier ‐ Preliminary Work” project in 

the quick start repository, using Xfmea/RCM++/RBI.
14 The Synthesis Platform Guide



3.4  Set Reliability Requirements

conditions in the Application field, as shown next. This information will be used during the FMEA and 
test design.

3.4  Set Reliability Requirements

Your next step is to set high-level reliability requirements. Depending on the industry and application, 
these could be driven by any of a number of factors, such as OEM specifications, marketing/customer 
needs, benchmarking specifications, best practices, costs, safety/regulatory concerns, contract 
requirements, etc. 

In this section, you will continue working with the “1. Chandelier ‐ Preliminary Work” 

project in the quick start repository. Some of the steps are performed in Weibull++ and 
some in Xfmea/RCM++/RBI.
The Synthesis Platform Guide 15

For the chandelier, the team decides to use a cost-based approach. 



3  Using the Synthesis Platform

You open the Synthesis Launcher from the Quick Access Toolbar to open the same project in Weibull++. 
(This feature can also be accessed by choosing File > Launch Application or Home > Launch > 
Another Synthesis Application.)

Then you open the Target Reliability tool and use the settings shown next (“Chandelier Target 
Reliability” in the sample project). The table at the top of the window contains the team’s inputs for the 
best, worst and most likely scenarios, while the plot shows the Cost vs. Reliability curves calculated based 
on those inputs.
16 The Synthesis Platform Guide



3.4  Set Reliability Requirements

Pointing to the Minimum Cost line in the plot, you see that the minimum cost is reached at a reliability of 
95.7958%. 

Based on this, the team decides on a target reliability of 95% for 5,000 hours of operation. 
The Synthesis Platform Guide 17



3  Using the Synthesis Platform

You return to Xfmea/RCM++/RBI by clicking its icon in the Windows taskbar. If the FMRA tab is not 
already visible in the System panel, choose View > Show > Show FMRA. You then enter these values on 
the Properties tab, as shown next. For other fields, default settings are kept.

3.5  Risk Discovery

With the target reliability specified, you can now take a closer look at the system. The basic design of the 
chandelier consists of the Frame, Wiring, and Bulb and Socket assemblies. In Xfmea/RCM++/RBI, you 
add assemblies and components to the system hierarchy, as shown next. 

In this section, you will switch to the “2. Chandelier ‐ Assess Design Reliability” project in the 

quick start repository, while still using Xfmea/RCM++/RBI.
18 The Synthesis Platform Guide

At this point, you begin to consider the issue of risk for the system. The purpose of this is to identify the 
critical items to focus on; you should perform FMEAs for these items.



3.5  Risk Discovery

For situations in which a prior design exists, the team might perform a change point analysis to assess 
what has changed in the new version. For items that have no changes and have performed satisfactorily in 
the prior design, further analysis may not be warranted. However, changes that can affect reliability may 
constitute a risk that requires further attention, such as:

 Change in the design.

 Change in the manufacturer.

 Change in the supplier, supplier design or process.

 Change in the usage environment.

 Change in the system - interface points.

 Change in the system - upstream and downstream parts.

 Change in the specification.

 Change in the performance requirements.

 Any other changes that can affect reliability.

Likewise, a similar set of assessment criteria can be applied to evaluate the risk in a new design.

Your team uses the configurable Risk Discovery feature in Xfmea/RCM++/RBI to perform separate 
analyses for four items in the system hierarchy: Frame, Wiring, Bulb and Socket. The specific questions 
used in this project are based on the “RS DFR Focus” profile that is installed with the software; they are 
suitable to consider either changes from a prior design or potential concerns with a new design (as is the 
case for this chandelier).
The Synthesis Platform Guide 19



3  Using the Synthesis Platform

The following picture shows the analysis for the Frame. To view all four analyses in the sample project, 
simply select each item and then view the Risk Discovery tab in the Analysis panel.
20 The Synthesis Platform Guide

Based on the results of these analyses, the team decides to perform Design FMEAs (DFMEAs) for all four 
items.



3.6  Design FMEAs

3.6  Design FMEAs

You use Xfmea/RCM++/RBI to record the DFMEAs for the Frame, Wiring, Bulb and Socket. Each 
DFMEA can be done by the same or different teams. A Risk Priority Number (RPN) approach is used to 
assist in prioritizing the causes that need mitigation.

For example, the following picture shows the FMEA for the Frame. (To see this analysis in the sample 
project, select the Frame in the system hierarchy and then view the FMEA tab in the Analysis panel.) 

For this item, the corrosion failure mode is the biggest concern. Its probability of occurrence, while just an 
estimate at this time, is worrisome. The team has determined that additional information is needed to 
better understand this failure mechanism (e.g., from literature searches on corrosion, expert opinion and/or 
testing). Therefore, the requirement to perform an accelerated test is recorded as an action in the FMEA.

In this section, you will continue working with the “2. Chandelier ‐ Assess Design Reliability” 

project in the quick start repository, using Xfmea/RCM++/RBI.
The Synthesis Platform Guide 21

Note: Within Xfmea/RCM++/RBI, different views of the FMEA are available, from a traditional spreadsheet‐style 

view  to a more efficient,  flexible and advanced hierarchical  view. This  guide uses  the hierarchical  view, which 
provides the most flexibility.



3  Using the Synthesis Platform

You also transfer this action to a Design Verification Plan (DVP&R) and attach some related documents, 
as shown next. (To see this analysis in the sample project, select the Frame in the system hierarchy and 
view the DVP&R tab in the Analysis panel.)

In a similar manner, the FMEAs for the Wiring, Bulb and Socket identify other issues of concern and 
additional tests that may help to improve the chandelier's reliability. (To view these analyses in the sample 
project, click each item in the system hierarchy and view the FMEA tab in the Analysis panel.)

When the FMEAs are completed, you add any relevant actions to the project plan. For example, the 
following picture shows the “Development” stage of the plan updated with frame corrosion and bulb test 
plans that were recommended by the FMEA team. 
22 The Synthesis Platform Guide

We will discuss some of the specific test results later in this document (Section 3.12 on page 47). 



3.7  Failure Modes and Reliability Analysis (FMRA)

3.7  Failure Modes and Reliability Analysis (FMRA)

Traditionally, DFMEA analysis focuses on qualitative inputs to assess and rank the risk associated with 
specific failure modes and their eventual mitigation, through an RPN approach or other ranking criteria. 
We may, however, wish to also use the FMEA as a starting point for certain quantitative analyses. 

ReliaSoft's powerful Failure Modes and Reliability Analysis (FMRA) view offers a representation of the 
system hierarchy that shows the FMEA functions, failures and causes for each item directly within the 
hierarchy.

This view allows you to assign reliability characteristics at the item level or at the function, failure or 
cause levels. This can be used for a variety of purposes, including the fault tree analysis that will be 
discussed in Section 3.8, the simulation-based risk assessment discussed in Section 3.9 and the baseline 
reliability estimation discussed in Section 3.10. 

To proceed with any of these analyses, we first need to quantify the failure or event probabilities for each 
cause in each FMEA. 

If prior data exist or time is available for testing, it is a simple matter to determine these probabilities. 
However, for the single-light pendant chandelier, no data are available at this point other than the 
qualitative inputs provided during the FMEA analysis in the form of the occurrence rating scale that was 
used for RPN calculation. We can use this information as a starting point because, even though qualitative, 
the scales used in any FMEA should have some quantitative equivalent (e.g., “Unlikely” is 1 in a million). 
The conversion of these inputs into either fixed numerical probabilities or simple lifetime distributions 
(e.g., exponential) provides a quantitative starting point. 

In this case, you know that the FMEA teams assigned occurrence ratings based on the probability that the 
failure would occur by 1,000 hours of operation. Therefore, it is possible to use a time-dependent 

In this section, you will continue working with the “2. Chandelier ‐ Assess Design Reliability” 

project in the quick start repository, using Xfmea/RCM++/RBI.
The Synthesis Platform Guide 23

exponential distribution instead of a fixed probability. This will allow the software to calculate the 
probability of failure for any operating time specified for the analysis (which is 5,000 hours in this case).



3  Using the Synthesis Platform

In Xfmea/RCM++/RBI, you configure the occurrence rating scale that has been defined for the current 
project as shown in the following picture. (To access this window, choose Project > Management > 
Configurable Settings > Occurrence.)

With these settings, a 1-parameter exponential model will be built for each occurrence rating using the 
probability of failure entered in the Quantitative Value field (Q) and the time specified for T (1,000 
hours), as follows: 

Probability of Failure at Time T = Q(T)

Assuming an exponential distribution, its single parameter  can be estimated as follows:
24 The Synthesis Platform Guide

It is common knowledge that the exponential distribution, with its assumption of a constant failure rate, is 
flawed for anything that exhibits any type of degradation (i.e., gets worse with age). However, for the 
purposes of a first cut estimate it is still useful. If the analyst feels that a more realistic model is needed, 
the occurrence probability can subsequently be easily modified to use any other distribution. The model 
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3.8  Fault Tree Analysis

can also be linked to source data, as demonstrated later in this guide. In the absence of data, you could also 
use the model wizard to more realistically describe the occurrence probability. For now, however, you 
decide to start with the exponential assumption.

Initially, you simply want to use the FMRA to assign reliability models to each cause in order to proceed 
with more complex risk analysis. To do this in the FMRA, you modify the reliability policy for each cause 
so that it is calculated based on the probabilistic model that corresponds to the initial occurrence rating. 
(These models are not resources that can be used elsewhere; they are simply representations of probability 
using an exponential distribution.) As an example, the following picture shows the FMRA properties for 
the Corrosion cause in the Frame FMEA.
The Synthesis Platform Guide 25

3.8  Fault Tree Analysis

You can now open the project in Blocksim, where you can quantify the chandelier’s overall risk of fire 
based on different causes in the FMEAs. 

In this section, you will continue working with the “2. Chandelier ‐ Assess Design Reliability” project in the 

quick start repository, using BlockSim.



3  Using the Synthesis Platform

In the chandelier, fire is a possible effect across various assemblies. The table below shows the portions of 
all of the FMEAs that lead to fire.

To combine all of this information together, BlockSim provides a convenient utility that queries the 
FMEAs that you performed in Xfmea/RCM++/RBI and automatically generates fault trees that show all 
of the possible failure modes that could result in a particular outcome. For example, the following picture 
shows the query that generates a fault tree for any failure effect that contains the word “fire.” (To access 

System Assembly Function Failure Effect(s)

Chandelier Frame Hold the chandelier 
together

Frame cracks No light; Break up of chandelier; 
Possible injury

Wiring Provide electricity Aging and stress Possible injury; Fire; No light

Bending Possible injury; Fire; No light

Chafing Possible injury; Fire; No light

Delamination Possible injury; Fire; No light

Terminal point connection 
failure

Possible injury; Fire; No light

Series arcing Possible injury; Fire; No light

Bulb Provide light Filament burns No light

Bulb shatters Possible injury; No light

Base fails to make contact No light

Insufficient light Customer dissatisfaction

Socket Provide electricity to 
bulb

Fails to make contact No light

Short Possible injury; Fire; No light
26 The Synthesis Platform Guide



3.8  Fault Tree Analysis

this utility in BlockSim, choose Insert > Build from Synthesis > Build Effect FTs from Synthesis.) This 
step has already been performed in the sample project. 

The resulting fault tree (“Fire_Probability” in the sample project) shows all of the possible failure modes 
that could result in fire and calculates the overall probability that fire may occur by 5,000 hours, as shown 
next.
The Synthesis Platform Guide 27
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It is a simple matter to do the same for the “possible injury” and “no light” effects. You then use these fault 
trees as subdiagrams in a fault tree (“Any_Effect” in the sample project) that shows the probability that 
any of these effects will happen by 5,000 hours, as shown next.

You also create an overlay plot (“Effect Probabilities of Occurrence” in the sample project) that shows 
how the probabilities of occurrence of the effects compare, as shown next. (Note that labels have been 
added here for clarity.)
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Finally, you return to the fire probability fault tree and publish it as a model that can be used in other 
analyses. The following picture shows the Publishing page of the fault tree's control panel, which provides 
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the tools you need to create and manage published models based on a particular BlockSim diagram. (To 
view this page, click the Publishing icon at the bottom of the control panel, as indicated in the picture.)

3.9  Using Flowchart Simulation and DOE

The information about risk that you have obtained thus far can be put to further use. For example, the 

In this section, you will continue working with the “2. Chandelier ‐ Assess Design Reliability” project 
in the quick start repository. Some of the steps are performed in RENO and some in DOE++.
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probability model that you created for the “fire” effect can now be used to help you understand the 
potential outcomes associated with fire and thereby assess and quantify the associated risk for the end 
user.

To evaluate the potential outcomes associated with fire, you build a RENO flowchart that starts with the 
probability of fire, based on the published model at 5,000 hours, and takes into account the following 
event probabilities:

 The probability of the fire being noticed right away = 0.2.

 If the fire goes unnoticed, the probability of the alarm being activated = 0.95.
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 If the alarm is activated, the probability of the fire department receiving the notification = 0.9.

 The probability of the fire department arriving in time = 0.9.

 The sprinkler system may be activated if the alarm fails or if the fire department fails to respond in 
time. The probability of the sprinkler system being successfully activated in either case = 0.9.

The following picture shows the flowchart (“Fire Effect Outcome” in the sample project), along with the 
properties of the originating event (i.e., fire).
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Simulating this flowchart and plotting the results gives you an idea of the probabilities of various 
outcomes.

In this case, the outcome of greatest concern to you is the possibility of injury. You decide to use Design of 
Experiments (DOE) analysis to determine the factors (or events) that have the greatest effect on the 
probability of injury due to fire.

To do this, you first duplicate the RENO flowchart. In the new flowchart (“Fire Effect Outcome DOE” in 
the sample project), you replace the following probability values with variables.

 Noticed
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 Alarm Activated

 Respond in Time

 Sprinkler Activated

A variable is a Synthesis resource that stores a numerical value and allows you to assign a name to that 
value. You can then use the variable name in place of the actual value in the equations that you create, and 
the value of the variable can be changed during simulation. 

For example, in the Block Properties windows shown next, the one on the left shows the probability of 
sprinkler activation defined as a constant (0.9) in the original flowchart, while the one on the right shows 
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it defined using a variable called “Sprinkler” in the new flowchart. The variable method allows you to try 
different values during simulation.

In the new flowchart, you also set the Injuries block (i.e., the resulting probability of injury) to store its 
value in a variable. Storing the result in this way will allow it to be used in a simulation worksheet, as 
explained in the following steps.

You then open the project in DOE++ and build a general full factorial design (“Injury from Fire” in the 
sample project) that sets eight different levels to be considered for each of the factors, as shown next. (To 
access this design summary in the sample project, click the Detailed Summary link on the Design tab of 
the design folio.)
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You then transfer the factor settings to a new simulation worksheet (“Simulation Worksheet1” in the 
sample project). In this case, you will access the same worksheet in both DOE++ and RENO in order to a) 
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design an experiment in DOE++, b) use a RENO flowchart to obtain the “response” data via simulation, 
and then c) return to DOE++ and analyze the simulated response data.

The following picture shows how the worksheet looks after you have transferred the factor settings from 
the experiment design, but before the response data has been populated by RENO. (You won't be able to 
see this stage of the analysis in the sample project. The simulation worksheet in the sample project is 
complete, and looks like the step shown on page 35.)

You click the Commit and Lock button in the control panel to save the changes and lock the worksheet in 
DOE++ so you'll be able to work with it in RENO.

You then return to RENO and open the same simulation worksheet. When you click the Simulate icon in 
the control panel, the Select Diagram window appears. In this window, you first select the flowchart 
diagram that will be used to generate the response data. Then you specify which variables from the 
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flowchart will be associated with the factors (inputs) and response (output) in the DOE analysis. The 
following pictures show these settings.

When you run the simulation (using 1,000 simulations with a seed of 1 for repeatability), the factor 
settings entered by DOE++ into the simulation worksheet are used by each specified variable in the 
RENO simulation. And likewise, the values generated by the RENO flowchart and stored in the Injury 
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variable are used to populate the DOE response column in the simulation worksheet. For example, 
consider the values in the first row of the simulation worksheet, as shown next.

In the first simulation, the value in the Noticed column, 0.4, is used by the Noticed variable to define the 
probability that the fire is noticed. Similarly, the AlarmAct variable is set to 0.3, the Sprinkler variable is 
set to 0.3 and the FDRespond variable is set to 0.5. Given these values in the flowchart simulation, the 
probability of injury is found to be approximately 0.005.

After the response data has been generated, you again commit and lock the simulation worksheet so you'll 
be able to work with it in DOE++.
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You return to DOE++ and refresh the simulation worksheet to display the response values that were 
generated from the flowchart simulation (i.e., the Injury probability for each combination of factors). 

You then transfer the response data from the simulation worksheet to the design folio. When you analyze 
the data set (“Injury from Fire” in the sample project), you see that three of the four factors are significant, 
along with several interaction effects, as shown next. 

You use a Pareto chart to view the effects of the significant terms, as shown next.
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From this plot, you determine that alarm activation and sprinkler system activation are the two main 
factors that influence injury.
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3.10  Estimate the Baseline System Reliability

You return to Xfmea/RCM++/RBI to work with the Failure Modes and Reliability Analysis (FMRA) that 
you created earlier (see Section 3.7 on page 23). This time, you will use the reliability models that were 
obtained from the FMEA occurrence ratings to generate a preliminary estimate of the system's baseline 
reliability.

Assuming that any one of the FMEA causes could cause the component to fail (i.e., the causes are 
reliability-wise in series), the FMRA combines the cause reliabilities to get the reliability of each 
component. It then combines the component and assembly reliabilities until reaching the system level.

The following picture shows the reliabilities calculated from the “first draft” FMRA that is based solely on 
the information from the FMEAs. For a system operating time of 5,000 hours, the computed reliability for 

In this section, you will continue working with the “2. Chandelier ‐ Assess Design Reliability” 

project in the quick start repository, using Xfmea/RCM++/RBI.
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the entire chandelier is about 84.95%. (This stage of the analysis is not visible in the sample project. The 
FMRA shown in the sample project reflects changes made during FMRA vetting, as explained next.) 
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It is extremely important to note at this point that this first draft FMRA system reliability value may be 
nowhere close to the true reliability value. You now need to go back through the first draft FMRA and 
review each entry and the overall result. This is called FMRA vetting.

When you begin to vet the first draft FMRA, the first thing you notice is that the “Bulb wattage too low” 
failure cause (which occurs if the user installs the wrong type of bulb) was something that needed to be 
considered during the FMEA, but it should not affect the chandelier’s calculated reliability. 

To prevent the software from considering this cause, you set the cause’s reliability policy to Define at this 
level and remove the URD that was previously assigned to the cause. The software will assign a model 
with 100% reliability (“Default - Cannot Fail”), as shown next. (This is how it appears in the sample 
project.).

FMRA Vetting: In general, the FMRA vetting process involves these two steps:

 Cleaning Up
During this step, you review the failure causes that are being considered in the analysis and 
perform any cleanup that may be required to make sure the FMRA considers all the causes 
that impact the system’s reliability, but does not consider causes that don't.

 Reviewing and Validating Inputs
During  this step, you examine  the calculated  reliability estimates  for each  record  to see  if 
they  fit your expectations.  If not, you determine which  inputs  to  the  FMRA and DFMEAs 
might need to be revised with better information.

The ReliaWiki resource portal provides more information about the FMRA vetting process at:
http://www.ReliaWiki.org/index.php/Using_FMRA_to_Estimate_Baseline_Reliability.
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This means that the cause record will essentially be ignored in the reliability calculations because the 
cause reliability will always be 100%. 

When you recalculate the FMRA after making this change, you find that the system reliability changed to 
approximately 85.80% (as shown in the sample project).

You continue reviewing the rest of the analysis and make any updates that may be appropriate. Once 
vetted, the baseline reliability value is your initial design reliability. You will compare this with the target 
reliability, keeping in mind that this first baseline estimate is usually optimistic because you have not 

http://www.reliawiki.org/index.php/Using_FMRA_to_Estimate_Baseline_Reliability
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accounted for other reliability contributors, including interactions. Furthermore, the product needs to go 
through manufacturing, and the manufacturing process will not increase the reliability. Thus, you want 
your initial baseline reliability value to exceed your reliability target value.

From a knowledge base viewpoint, it is also important to note that the FMEA and related FMRA should 
be updated continuously as new information becomes available, including the addition of new failure 
modes uncovered during testing as well as the revision of the underlying reliability models based on data 
obtained from testing. Upon the product’s release, this process should continue with field information. 

3.11  Identify Reliability Gaps

Your next task is to perform a more advanced system analysis in order to better understand the system 
reliability and evaluate where to focus your efforts for improving the reliability. 

You open the project in BlockSim and use the Build RBDs and FTs from Synthesis utility to create a set 
of reliability block diagrams (RBDs) based on the latest information from the FMEAs and FMRA. The 
following picture shows the settings that were used to create these diagrams.

In this section, you will switch to the “3. Chandelier ‐ Identify Reliability Gaps” project in the quick start 
repository, and perform the analysis using BlockSim.
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You open the main diagram, called “Chandelier,” which contains subdiagrams that represent the three 
assemblies. You then double-click each subdiagram to see its components. The following image shows all 
of the diagrams in relation to each other.
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You analyze the main diagram and then choose Analysis > Analytical QCP. You see that BlockSim's 
QCP returns the same reliability result for R(t=5,000) as the FMRA view in Xfmea/RCM++/RBI. 

Now you want to investigate how to improve this number to get to the target reliability.

One approach is to start at the system level and look at the reliability importance of each assembly. 
Reliability importance is a measure of how much effect each assembly or component has on the overall 
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reliability of the system. The following picture shows the Static Reliability Importance plot for the 
“Chandelier” diagram (which is accessible from the Analytical Plot sheet in the diagram window).

You can view the same plot for the other diagrams, all the way down to the underlying causes.
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Alternatively, BlockSim's FRED reports offer a less time-consuming and more readily understood 
approach. A FRED report can automatically trace the entire RBD structure and highlight the root causes 
from a reliability perspective, as shown next (“FRED Report1” in the sample project). 

Here, all items with low reliability have been expanded to show the items that contribute to the problem. 

 The Bulb and Socket assembly is clearly the primary unreliability driver. Within that assembly:

 The Bulb is the major contributor.

 The Bulb’s primary root cause of failure is the tendency of the filament to burn. 

 The secondary unreliability driver is the Frame assembly.
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 The Frame’s primary root cause of failure is corrosion. 

Having identified these root causes, the next course of action may be to question the FMEA team as to the 
reasons behind each cause. This more advanced look at the FMEA, through a system reliability focus, 
highlights items that need further attention and investigation, and items that need to be addressed in order 
to meet the target reliability. 

You can also use the BlockSim diagrams to determine the target reliability for these assemblies and failure 
causes of interest. To do this, you add an allocation analysis (“Allocation Analysis” in the sample project), 
based on the Chandelier diagram. On the control panel, you change the inputs to reflect the goal of 95% 
reliability at 5,000 hours and choose the cost optimized allocation type. You change the color limits to 
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85%-100% to make the analysis easier to read, and you clear the check box for the Wiring assembly, 
because the causes of interest (as determined via the reliability importance plot and/or the FRED report) 
do not relate to that assembly. The resulting allocation analysis is shown next. 

To view more specific results on the Frame assembly, you click its name in the table. This adds an 
additional allocation analysis to the folio with the target reliability already in place. The current reliability 
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for the “Metal fatigue” cause is already almost 100%, so you clear the check box for that cause. The 
calculated allocation analysis for the Frame assembly is shown next.

The Corrosion cause was one of the causes of interest identified in the FRED report. In the Target 
Reliability column for this cause, you see that the reliability value that should be achieved for the 
Corrosion cause, in order for the Frame assembly to reach its target reliability, is about 98.21%.
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You then return to the Chandelier tab and click the name of the Bulb and Socket assembly to create an 
allocation analysis for it, as shown next.

You will recall that the Bulb was the main contributor to the unreliability of this assembly. Because the 
Bulb is a component that you purchase, you do not need to examine it at the cause level; a single target 
reliability for the component is sufficient. The value shown in the Target Reliability column for the Bulb is 
about 98.37%. The Socket was not a significant contributor to unreliability and does not require further 
analysis.

3.12  Improve the Reliability

In this section, you will work with the “4. Chandelier ‐ Improve Reliability” project 
The Synthesis Platform Guide 47

With the primary root causes identified, the team can now focus on increasing the reliabilities of these 
specific items in order to assure that the target will be met. To do this, you expand the analysis to include 
models created from data. 

Up to this point, the models and modeling assumptions used have been fairly simplistic and based on the 
qualitative values entered in the DFMEA. As the design effort progresses, these reliability estimates can 
be replaced with more robust estimates. These could be based on actual test data, reliability growth data, 

in the quick start repository. Some of the steps are performed in Weibull++/ALTA 
and some in Xfmea/RCM++/RBI.
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simulations, etc. By performing these analyses in other Synthesis applications, you can create newer 
quantitative models to replace the first cut approximation. 

For example, as you saw in the allocation analysis, the current reliability associated with the Corrosion 
cause is about 95.10%. This indicates that corrosion occurs in about 5 out of every 100 items. You 
determined in the allocation analysis that this needs to be improved to 98.21%, or approximately 18/1,000. 
To address this, you proceed with the accelerated corrosion test requested by the FMEA team (see Section 
3.6 on page 21).

You perform an analysis of humidity readings from throughout the country in Weibull++ (“Environmental 
Data” in the sample project), based on the data in the Excel file attached to the project plan. Then you use 
the QCP to obtain the mean humidity value, as shown next.
48 The Synthesis Platform Guide



3.12  Improve the Reliability

Next, you perform the accelerated life testing for frame corrosion that was requested. Using the mean 
humidity value you just obtained as the use stress for humidity, you then analyze the data in an ALTA 
standard folio (“Corrosion ALT” in the sample project).
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Using the QCP to calculate the reliability at 5,000 hours, you get a result of 99.33%.
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You publish the model, as shown next, to make it available for subsequent use in the FMRA.

Another issue is bulb reliability. In this case, your team considers three bulb models (61A, 69C and A14) 
for use in the chandelier, as requested by the FMEA team (see Section 3.6 on page 21). 
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For model A14, you perform an accelerated life test and analyze the data in an ALTA standard folio 
(“Bulb Model A14” in the sample project).
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For the other two bulbs (61A and 69C), you perform traditional life tests and analyze the data with 
Weibull++ standard folios (“Bulb Model 61A” and “Bulb Model 69C” in the sample project).

You then create an overlay plot (“Bulb Testing” in the sample project) that shows how the reliabilities of 
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the bulbs compare. You will recall that the results of the allocation analysis, shown on page 47, gave a 
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target reliability for the Bulb of 98.37% at 5,000 hours. This target reliability is marked on the overlay 
plot, as shown next. (Note that labels have been added here for clarity.)

You can see that only bulb A14 meets the target requirement, so you recommend that A14 be used in the 
design.
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You publish the model for the selected bulb, A14, as shown next.
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You then return to Xfmea/RCM++/RBI and use the models that you have just published to describe the 
probability of the Corrosion cause and the reliability of the Bulb. First, you change the cause’s reliability 
policy type to Define at this level and select the corrosion model in the Model field.
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You do the same for the Bulb, replacing the reliability estimate that was calculated by rolling up the 
probabilities for the failure causes.

When you recalculate the FMRA, you see that the reliability value associated with the Corrosion cause at 
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5,000 hours is now about 99.33%, which is more than good enough to meet the goal of 98.21% that was 
determined in the allocation analysis. Similarly, the Bulb’s reliability at 5,000 hours is now 99.25%, which 
exceeds the goal of 98.37%.

The overall reliability of the chandelier with these changes is now approximately 95.42%, which meets 
the target reliability.
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3.13  Consider a Design Change

At this point, your company considers the possibility of developing a new chandelier model that uses a 
dimmable LED light source, in order to keep up with the latest technology on the market. This model 
would use the existing design, except the incandescent bulb would be replaced with a commercial off-the-
shelf LED bulb, and an LED controller would be added.

An accelerated test has provided some degradation data for the LED bulb that you can analyze in ALTA. 
You decide to use the Telcordia reliability prediction standard in Lambda Predict to calculate a predicted 
failure rate for the controller.

First, you duplicate your project so that you can make changes to the system without losing your original 
work. In the new project, you perform the accelerated degradation analysis (“Accelerated Degradation - 
LED Lamp” in the sample project) in ALTA, as shown next, and publish the model.

In this section, you will switch to the “4a. Chandelier ‐ Design Change” project in 

the quick start repository. Some of the steps are performed in ALTA, some in 
Lambda Predict and some in Xfmea/RCM++/RBI.
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In Lambda Predict, you perform the reliability prediction (“Dimmer Controller” in the sample project), as 
shown next.

You publish the model for the Dimmer Controller system by selecting the system and choosing Prediction 
Tools > Share > Publish Item Model. 
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You then open this project in Xfmea/RCM++/RBI and change the system hierarchy to include the 
Controller and LED Bulb, as shown next.
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In the FMRA view, you use the ALTA model that you published to describe the reliability of the LED 
light. 

You use the model from Lambda Predict to describe the reliability of the controller.

Calculating the FMRA, you see that the reliability estimate for the LED version of the chandelier is about 
90.41%, as shown next.
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This represents a significant decrease in reliability from the version of the chandelier that uses the 
incandescent bulb, which had an estimated reliability of 95.42%. The company decides to shelve the plans 
for the LED design temporarily, and you return your focus to the original design.

3.14  Testing and Ongoing Product Development

(Note that the steps described in this section are not visible in the sample project.)

Throughout the rest of the chandelier’s life cycle, you will continue to perform tests and other activities to 
quantify and improve the reliability of your product. You will use XFRACAS (a web-based failure 
reporting analysis and corrective action system) to record and manage information about new failure 
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modes and issues that are discovered, as well as about the actual occurrence of failure modes that were 
anticipated in the FMEA.

As new information becomes available, you will analyze the data to publish new models and update 
existing ones. The data can be obtained from a variety of channels, including testing, field performance 
and data sets extracted from XFRACAS. At any time, you can pull data for one or more parts from 
XFRACAS into the Synthesis Data Warehouse (SDW). From there, you can transfer the data set into 
Weibull++ or ALTA for life data analysis and/or into RGA for reliability growth analysis.
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You can also use the XFRACAS data to improve the FMEA and maintenance plans. This includes adding 
new failure modes that have been observed during testing and/or in the field, as well as improving the 
accuracy of occurrence ratings based on the number of times that failure modes actually occurred.

3.15  Maintenance Planning

The system configuration and reliability information that you have developed from prior analyses can 
easily be adopted for life cycle cost and maintenance planning in BlockSim and RCM++/RBI. In this case, 
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you decide to estimate the availability and maintenance costs that your customers are likely to experience 
after purchasing and installing your new chandelier. You expect that customers will replace the chandelier 
entirely if there are problems with the frame or the wiring. They will replace burned-out bulbs themselves, 
but will need to call an electrician for socket issues. 

3.15.1  Defining Reliability Models at the Component/Assembly Level

For prior analyses, the system hierarchy and the DFMEA went down to specific root causes to determine 
actions to improve reliability and to define reliability design targets for specific failure modes. This makes 
sense during development. From a reliability-based maintenance perspective, however, information on the 
causes or failure modes may need to be less detailed, because the actions to address the failures would be 
at a higher level. For example, regardless of what caused the bulb to fail, the entire bulb must be replaced 
to restore the system. Addressing causes below the bulb failure level adds no value in this case, as the 
resulting action would be identical. Thus, the reliability does not need to be inherited from the underlying 
causes, but rather can be defined at the component/assembly level. 

So the next step is to assign reliability models for the Frame, Wiring, Bulb and Socket, which can then be 
used for maintenance planning. To do this, you return to the same FMRA analysis that you created in 
Xfmea/RCM++/RBI, but now you will work with the analysis in BlockSim. Editing the same FMRA in 
both applications is like having the same document open in two software windows. Any changes that are 
made in one location will be applied to the other when you synchronize the two. 

In this section, you will switch to the “5. Chandelier ‐ Maintenance Planning Part 1” project in the quick 

start repository, using BlockSim.

Note: Since they are directly linked, any changes made in the FMRA are also made in the FMEA. For example, if 

you delete a block that represents a cause from the FMRA view in BlockSim, this will automatically delete it from 
both the FMRA and the associated FMEA in Xfmea/RCM++/RBI. The same holds true when you change properties, 
etc. For this reason, it is important to exercise caution in this environment. 
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If the FMRA tab is not already visible when you open the sample project in BlockSim, choose View > 
Show > Show FMRA to display it. You can see the that the reliability of the Bulb is now obtained from 
the accelerated life testing data analysis that you performed in ALTA, while the reliabilities of the Frame, 
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Wiring and Socket are still being “inherited” from the failure mode occurrence models obtained from the 
FMEAs. 
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To obtain a reliability model that can be applied directly to the Frame, you first double-click the item in 
the FMRA hierarchy to see its reliability block diagram. Then you analyze the diagram and use the 
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Distribution Estimator to fit a model that represents the entire assembly. The following picture shows the 
results.

Then you go to the Publishing page of the diagram's control panel and publish this fitted model as a 
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Synthesis resource that represents the reliability of the Frame.

You follow a similar process to create and publish models for the Wiring and Socket. (To see these 
diagrams in the sample project, double-click each item in the FMRA hierarchy.)

3.15.2  Assigning the Models in the FMRA
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To use the new published models in the FMRA, you select each item and choose FMRA > Inheritance > 
Define at this level. This turns the item from a diagram (in which the reliability was calculated from sub-
items and/or failure modes) into a single block. You then double-click the item to open the block 

In this section, you will switch to the “6. Chandelier ‐ Maintenance Planning Part 2” project in the quick 

start repository, still using BlockSim.



3  Using the Synthesis Platform

properties and assign the published reliability model. The following picture shows the updated FMRA, as 
well as the model that has now been assigned to the Frame block.

3.15.3  Creating the Maintenance Tasks

In this section, you will continue working with the “6. Chandelier ‐ Maintenance Planning Part 2” 
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Now that the FMRA has been updated, you return to RCM++/RBI to define the expected maintenance 
strategy and calculate the metrics of interest. 

project in the quick start repository, now using RCM++/RBI. Note that this part of the analysis cannot 
be performed in Xfmea.



3.15  Maintenance Planning

To see the corrective task for the Bulb (“Replace Failed Bulb” task), select the item in the FMRA 
hierarchy, click in the Corrective Task field and then click the View/Edit icon.
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The task properties are as follows:

 The bulb will be replaced when it fails. 

 It takes an average of 5 minutes with a standard deviation of 1 minute to actually replace the bulb. 
This is represented by the “Replace Bulb Time” model.

 The bulb will be replaced by the owner of the chandelier. To see the “Owner” crew properties, 
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click in the Crew (Priority 1) field and then click the View/Edit icon.

 It takes the owner about 10 minutes with a standard deviation of 2 minutes to get the ladder and 
set it up. This is represented by the “Ladder Retrieval Time” model.

 The owner does not keep spare bulbs on hand and will have to purchase one from a nearby home 
improvement store. To see the “Bulb Purchase” spare part pool properties, click in the Spare Part 
Pool field and then click the View/Edit icon.

 The cost for the bulb is around $5 with a standard deviation of $0.50. This is represented by the 
“Bulb Price” model.



3.15  Maintenance Planning

 The drive time, in-store time and return time for a trip total about 2 hours (120 minutes) with a 
standard deviation of 20 minutes, depending on the traffic and how busy the store is. This is 
represented by the “Trip Time” model.

 The car expenses (fuel, etc.) to get to the store are about $6.00 with a standard deviation of $0.50. 
These costs are represented by the “Drive Costs” model.

To see the corrective task for the Socket (“Replace Socket” task), select the item in the FMRA hierarchy, 
click in the Corrective Task field and then click the View/Edit icon. The task properties are as follows:
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 The socket will be replaced when it fails. 

 It takes an average of 60 minutes (with a standard deviation of 20 minutes) to perform the socket 
replacement. This is represented by the “Replace Socket Time” model.



3  Using the Synthesis Platform

 If the socket fails, an electrician needs to be called. To see the “Electrician” crew properties, click 
in the Crew (Priority 1) field and then click the View/Edit icon.

 On average, it takes 4 days with a standard deviation of 1 day for the electrician to arrive after 
the owner calls to schedule an appointment. This is represented by the “Electrician Scheduling 
Delay” model.

 The electrician will charge $90 per hour, represented by the “Electrician Cost per Hour” model, 
plus a fixed fee of $50 per call, represented by the “Electrician Cost per Call” model.

 The electrician may or may not have a spare socket available. To see the “Socket Part” spare part 
pool properties, click in the Spare Part Pool field and then click the View/Edit icon.

 There is a $50 charge for the spare socket that will be used for the repair. This is represented by 
the “Socket Price” model.

 There is also a 50% chance that the electrician will not have a spare socket available. This is set 
by choosing Fixed probability of stockout in the Spare acquisition type field and entering 
0.5 in the Fixed probability value field.

 If no socket is available, the electrician will drive to a nearby home improvement store (the 
same store where the owner buys spare bulbs) to purchase one. This is represented by the “Trip 
Time” model.

You want to know the system availability and associated costs, assuming a use of 5,000 hours. To show 
the Simulation Results Status, Operating Cost and Availability columns in the FMRA, right-click a 
column header and click Customize Columns.

You simulate the FMRA using an Operation Time of 5,000 hours (running 1,000 simulations, using a 
starting seed of 1 and a single thread).
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You see that the projected system availability is approximately 99.60%, and the projected operating cost is 
$2.83.



Click Wrap License only -Software Maintenance provisions dealt with in separate agreement. 

 
End User License Agreement  

Click Wrap Agreement at time of product installation 

BY INSTALLING THIS SOFTWARE OR BY CLICKING THE “I ACCEPT” BUTTON 
AND ACCEPTING THIS LICENSE IN ACCORDANCE WITH SOFTWARE 
INSTALLATION AND LICENSE ACCEPTANCE PROCEDURE YOU AGREE TO THE 
TERMS OF THIS LICENSE WHICH WILL BIND YOU, THE COMPANY ON WHO’S 
BEHALF YOU ARE ENTERING INTO THIS LICENSE AGREEMENT, AND ITS 
EMPLOYEES, AS APPLICABLE.   

THIS LICENSE AGREEMENT IS A LEGAL AGREEMENT BETWEEN HBM UNITED 
KINGDOM LTD A COMPANY INCORPORATED IN UNITED KINGDOM WHOSE 
REGISTERED NUMBER IS 1589921 AND WHOSE REGISTERED OFFICE IS AT 
TECHNOLOGY CENTRE, ADVANCED MANUFACTURING PARK, BRUNEL WAY, 
CATCLIFFE, ROTHERHAM S60 5WG (THE ‘LICENSOR’) AND THE END USER 
LICENSEE OR ITS REPRESENTATIVE/AGENT AUTHORISED TO BIND THE END 
USER LICENSEE (‘YOU’). 

PLEASE READ THIS CAREFULLY BEFORE USING THE SOFTWARE 
PRODUCTS 

A: BACKGROUND 

THIS LICENSE AGREEMENT SHALL BE BETWEEN YOU AND THE 
LICENSOR REGARDLESS OF WHETHER YOU HAVE PURCHASED THE 
SOFTWARE PRODUCTS DIRECTLY FROM THE LICENSOR OR AN 
AUTHORISED RESELLER AS SET OUT BELOW. 

THE LICENSOR APPOINTS EXPERIENCED PROVIDERS OF SOFTWARE 
RESALE SERVICES WHO DISTRIBUTE THE SOFTWARE PRODUCTS TO 
END USERS (‘AUTHORISED RESELLER’). IF YOU HAVE PURCHASED 
THE SOFTWARE PRODUCTS AND ANY ASSOCIATED SUPPORT AND 
MAINTENANCE SERVICES FROM AN AUTHORISED RESELLER, SUCH 
PRODUCTS AND SERVICES WILL BE PROVIDED DIRECTLY TO YOU BY 
THE RELEVANT AUTHORISED RESELLER AND ALL PAYMENTS SHALL 
BE MADE TO THE AUTHORISED RESELLER ON THE AUTHORISED 
RESELLER’S TERMS AND PRICES.  



 

IF YOU HAVE PURCHASED THE SOFTWARE PRODUCT AND SUPPORT 
AND MAINTENANCE SERVICES DIRECTLY FROM THE LICENSOR, SUCH 
SUPPORT AND MAINTENANCE SERVICES WILL BE DEALT WITH IN A 
SEPARATE AGREEMENT BETWEEN YOU AND THE LICENSOR AND ALL 
PAYMENTS WILL BE MADE TO THE LICENSOR AND GOVERNED BY 
THE LICENSOR’S TERMS OF SALE. 

B: PROPERTY OF LICENSOR 

THE LICENSOR, OR, WHERE APPLICABLE, THE RELEVANT MEMBER OF 
THE LICENSOR’S CORPORATE GROUP, IS THE ENTIRE LEGAL AND 
BENEFICIAL OWNER OF CERTAIN SOFTWARE PRODUCT(S) (‘THE 
SOFTWARE PRODUCT’) AS SET OUT IN THE QUOTATION OF 
INFORMATION, WHICH SHALL ALSO INCLUDE YOUR LICENSE KEY, 
SENT TO YOU BY EMAIL EITHER BY THE LICENSOR OR, IF YOU HAVE 
PURCHASED THE SOFTWARE PRODUCTS FROM AN AUTHORISED 
RESELLER, BY THE AUTHORISED RESELLER (‘QUOTATION’). THE 
LICENSOR IS WILLING TO GRANT YOU A LICENSE TO USE THE 
SOFTWARE PRODUCT ONLY IF YOU ACCEPT ALL THE TERMS AND 
CONDITIONS SET OUT BELOW. 

C: LICENSE TO BE GRANTED 

THE LICENSOR IS PROPOSING TO GRANT YOU ONE OF THE FOUR 
FORMS OF LICENSE IN RESPECT OF THE SOFTWARE PRODUCT. 
DETAILS OF EACH FORM OF LICENSE ARE SET OUT IN CLAUSES 2.1 
AND 3 BELOW. THE FORM OF LICENSE THAT IS PROPOSED TO BE 
GRANTED TO YOU IS SET OUT IN THE QUOTATION. THE QUOTATION 
FORMS PART OF THE LICENSE AGREEMENT AND BY ACCEPTING THE 
TERMS OF THE LICENSE YOU ARE ACCEPTING THOSE TERMS IN THE 
QUOTATION. IF YOU HAVE NOT RECEIVED THE QUOTATION FROM 
EITHER THE LICENSOR OR FROM THE AUTHORISED RESELLER (IF YOU 
HAVE PURCHASED THE SOFTWARE PRODUCTS FROM AN 
AUTHORISED RESELLER) AT THE DATE HEREOF OR IF ANY DETAILS 
WITHIN THE QUOTATION ARE INCORRECT THEN YOU SHOULD 
FOLLOW THE ‘LICENSE REJECTION PROCEDURES’ SET OUT AT 
PARAGRAPH E BELOW AND IMMEDIATELY CONTACT THE LICENSOR 
OR THE AUTHORISED RESELLER (AS APPLICABLE). 



 

D: LICENSE ACCEPTANCE PROCEDURE 

BY CLICKING ON THE ACCEPTANCE BUTTON WHICH FOLLOWS THIS 
LICENSE AGREEMENT (MARKED 'DO YOU ACCEPT THESE TERMS AND 
CONDITIONS?'), YOU INDICATE ACCEPTANCE OF THIS LICENSE 
AGREEMENT AND THE LIMITED WARRANTY AND LIMITATION OF 
LIABILITY SET OUT IN THIS LICENSE AGREEMENT. SUCH 
ACCEPTANCE IS ON YOUR OWN BEHALF, IF YOU ARE AN INDIVIDUAL 
AND ON BEHALF OF ANY CORPORATE ENTITY WHICH EMPLOYS YOU 
OR WHICH YOU REPRESENT (‘CORPORATE LICENSEE’) IN ENTERING 
INTO THIS LICENSE AND YOU WARRANT THAT YOU HAVE THE 
NECESSARY AUTHORITY TO BIND THE CORPORATE ENTITY IN THIS 
RESPECT OR THAT THE AUTHORISED REPRESENTATIVES OF THE 
CORPORATE ENTITY ARE AWARE OF YOUR ACCEPTANCE OF THIS 
AGREEMENT ON ITS BEHALF. IN THIS LICENSE AGREEMENT, ‘YOU’ 
REFERS TO THE LICENSEE, ANY SUCH CORPORATE LICENSEE, OR 
BOTH, AS A COMMON SENSE INTERPRETATION OF THE RELEVANT 
SECTION DICTATES. 

E: LICENSE REJECTION PROCEDURE 

IF YOU DO NOT ACCEPT THESE TERMS AND CONDITIONS, YOU 
SHOULD CLICK ON THE “I DO NOT ACCEPT” BUTTON, DELETE THE 
SOFTWARE PRODUCTS FROM YOUR COMPUTER AND PROMPTLY (AND 
IN ANY EVENT, WITHIN 14 DAYS OF RECEIPT) RETURN TO THE 
RESELLER (A) ANY MEDIA; AND (B) ANY OTHER ITEMS PROVIDED, 
THAT ARE PART OF THIS PRODUCT. 

F: OTHER AGREEMENTS 

IF THE LICENSOR HAS EXPRESSLY AGREED WITH YOU IN WRITING 
THAT YOUR USE OF THE SOFTWARE PRODUCTS IS GOVERNED BY A 
PRIOR EXECUTED LICENSE AGREEMENT WITH THE LICENSOR, SUCH 
AGREEMENT SHALL APPLY INSTEAD OF THE FOLLOWING TERMS AND 
CONDITIONS TO THE EXTENT THAT THEY CONFLICT. 

YOU SHOULD PRINT A COPY OF THIS LICENSE AGREEMENT FOR 
FUTURE REFERENCE. 



 

LICENSE AGREEMENT  

1. Ownership of Software Products and Copies 

1.1 The Software Products and any printed materials or electronic documentation 
accompanying the Software Products (‘Documentation’) are copyrighted works of 
authorship, and are also protected under applicable database laws. The Licensor, or, 
where applicable, the relevant member of the Licensor’s corporate group, retains 
ownership of the Software Products and all subsequent copies of the Software 
Products, regardless of the form in which the copies may exist. This License 
Agreement is not a sale of the original Software Products or any copies. 

2. Commercial License 

2.1 In consideration of you agreeing to abide by the terms of this License Agreement and 
payment of the applicable license fees either to the Licensor or, if you have purchased 
the Software Products from an Authorised Reseller, to the Authorised Reseller (as 
specified in the Quotation), the Licensor hereby grants to you a personal, non-
exclusive, and (unless expressly agreed otherwise by the Licensor in accordance with 
clause 5.1) non-transferable license to use the Software Products and the 
Documentation on the terms of this License Agreement. The license shall take one of 
the following forms, (and shall be set out in the Quotation): 

(a) Annual License: 

(i) Duration – this License shall continue for a period of 12 months (‘Initial 
Period’) from the date of delivery of the Quotation (“the Delivery Date”) 
and, provided that you have paid all applicable renewal fees, from year 
to year thereafter unless terminated in accordance with any provision of 
clause 10 below or any other clause of this License Agreement. 

(ii) Termination – you must give the Licensor 90 day’s written notice prior 
to the anniversary of the Delivery Date, such notice not to expire before 
such anniversary date.    

(b) Paid Up License: 

(i) Duration – this License shall continue for a period of 25 years from the 
Delivery Date unless terminated in accordance with any provision of 
clause 10 below or any other clause of this License Agreement. 

(ii) Conversion - this License may be converted to a CDS (this may include 
CRS and CDRS which are specific variations of CDS and collectively 
known as CDS) License, upon application to either the Licensor or the 
Authorised Reseller (if you have purchased the Software Products from 



 

an Authorised Reseller),  and payment of an additional fee  to the 
Licensor or the Authorised Reseller (as applicable),  which shall be 
additional to the fees paid or payable in respect of any maintenance and 
support services provided by either the Licensor or the Authorised 
Reseller (if you have purchased the Software Products from an 
Authorised Reseller). You may reverse this conversion to the same terms 
as agreed in the Paid Up License at the anniversary of the conversion by 
giving the Licensor 90 days written notice prior to the anniversary of the 
Delivery Date, such notice not to expire before the anniversary of the 
Delivery Date. 

(c) CDS/CRS/CDRS License: 

(i) Access – subject to the terms and conditions of this License Agreement, 
you may access any of the Software Products in the Quotation at any one 
time and in any combination up to the number of subscriptions granting 
you access to the Software Products for simultaneous use by you and 
purchased by you pursuant to this Agreement  (‘Access Credits’). In the 
event the number of Access Credits reaches the number of Access 
Credits duly paid for by you (‘Access Limit’), you may add additional 
Access Credits (or, alternatively, at any time during the Term) which 
shall be charged in accordance with either the Licensor’s prices or the 
Authorised Reseller’s prices (if you have purchased the Software 
Products from an Authorised Reseller). Such increase in Access Credits 
shall apply to the following 12 month period, unless you give the 
Licensor or the Authorised Reseller (as applicable) written notice at least 
90 days in advance of the expiry of the Initial Period, that you do not 
wish to sustain such increase in Access Credits. You may opt to reduce 
the number of Access Credits with 90 days written notice in advance of 
the 12 month period following from the anniversary of the Delivery 
Date, provided that the total number of Access Credits does not fall 
below the minimum threshold set by the Licensor or the Authorised 
Reseller (as applicable) or below the initial number of Access Credits 
calculated at the time of conversion of any Paid Up License. 

(ii) Duration - this License shall continue for the Initial Period and, provided 
that you have paid for the applicable Access Credits, from year to year 
thereafter unless terminated in accordance with any provision of clause 
10 below or any other clause of this License Agreement. 

(iii) Reporting – in order to serve our customers better, the Licensor needs to 



 

be able to understand how its customers use the CDS system. As a 
condition of your continued access to the system, you are asked to 
provide to the Licensor on a quarterly basis, the CDS log file. You will 
be provided with easy-to-follow instructions on how to do this. 

(iv) Termination – you must give the Licensor 90 days written notice in 
advance of the expiry of the Initial Period of your intention to 
discontinue the CDS License, such notice not to expire before the 
anniversary of the Delivery Date, and you must have submitted all 
reports required of you in clause 2.1(c)(iii) above. Failure to provide 
such notice and reports will mean that the license shall automatically 
continue on the same terms until terminated in accordance with this 
clause.  

2.2 As an end user licensee of the Software Products, you may, subject to the following 
conditions and any conditions specified in the Quotation: 

(a) use and copy the Software Products only for use on any computer system that 
is detailed in the release notes of the respective Software Product and which is 
licensed, leased and/or controlled by you (the Corporate Licensee) or any 
member of your corporate group, which expression includes the Corporate 
Licensee's majority-owned subsidiaries, any parent company having a 
majority-owned interest in the Corporate Licensee, and such parent's majority-
owned subsidiaries; 

(b) load the Software Products into and use it only on computers at the locations 
specified in the Quotation and which are under your control;  

(c) copy the Software Products only for back-up and archival purposes and make 
up to three copies of the Documentation, provided that the original and each 
copy is kept in your possession and that your installation and use of the 
Software Products does not exceed any restrictions contained in the Quotation. 

3. Demonstration License 

3.1 If the Licensor has provided you with the Software Products free of charge for 
evaluation purposes, this clause 3 shall apply to your use of the Software Products.  

3.2 You may use the Software Product on a computer solely for the purposes of 
evaluating the Software Product. 

3.3 The Software Product is provided to you free of charge and on an “AS IS” basis, 
without any technical support or warranty of any kind from us including, without 



 

limitation, a warranty of satisfactory quality, fitness for purpose and non-
infringement. 

3.4 This License shall continue for a period of 30 days from the Delivery Date unless 
terminated in accordance with any provision of clause 10 below or any other 
applicable clause of this License Agreement or until such License is converted into 
an Annual License, Paid Up License or CDS License, if earlier. 

3.5 As part of the Licensor’s testing and evaluation of the Software Products, you shall 
share with the Licensor the input and views received and any reports and analysis 
produced promptly upon receipt of such feedback.  
 

3.6 Clauses 4, 5.1(a), 6.1(b), 6.1(f), 8.1, 8.2, 8.5, 10.1(a) of this License Agreement shall 
not apply to a Demonstration License. 

4. Delivery and Risk 

4.1 The Software Products shall consist of one copy of the object code of the Software 
Products on machine-readable form only, on the disk, dongle or other media on 
which the Software Product                   is delivered as described in the Quotation (the 
“Media”). Risk in the Media shall pass to you on delivery. If any part of the Media 
shall thereafter be lost, damaged or destroyed, you must contact either the Licensor or 
the Authorised Reseller from whom you have purchased the Software Products who 
will arrange for a repair or replacement of such Media at a cost (if any) determined 
by the Licensor or the Authorised Reseller (as applicable). 

5. License Restrictions 

5.1 You may not nor permit others to: 

(a) transfer the Software Products from one location to another, without the 
express written consent of the Licensor and provided such transfers do not 
exceed two in any twelve month period.  It will be a condition of the grant of 
any such consent that the Software Products held on hard drives at the current 
location must be erased and you must enter into a new license agreement with 
the Licensor before a Software Products license key is provided to you.  The 
administration charge (currently US $1,500) will be payable by you in respect 
of such transfer. This charge is only applicable to end user licensees who do 
not have a support and maintenance services agreement with the Licensor  or 
Authorised Reseller;  

(b) exceed the number of concurrent users specified in the Quotation, if any;  

(c) sub-license, sell, assign, rent, pledge, lease, transfer or otherwise dispose of the 



 

Software Products, on a temporary or permanent basis, without the prior 
written consent of the Licensor; 

(d) translate, reverse engineer, decompile, disassemble, modify or create derivative 
works based on the Software Products except as permitted by law; 

(e) make copies of the Software Products, in whole or part, except for back-up or 
archival purposes as permitted in this License Agreement; 

(f) use any back-up copy of the Software Products for any purpose other than to 
replace the original copy in the event that it is destroyed or becomes defective; 

(g) copy the Documentation (except as provided by this License Agreement); 

(h) adapt, modify, delete or translate the Documentation in any way for any 
purpose whatsoever; 

(i) vary, delete or obscure any notices of proprietary rights or any product 
identification or restrictions on or in the Software Products. 

6. Undertakings 

6.1 You undertake: 

(a) to ensure that, prior to use of the Software Products by your employees or 
agents, all such parties are notified of this License and the terms of this License 
Agreement and that any such use as aforesaid is in accordance with the terms 
of this License Agreement; 

(b) to replace the current version of the Software Product with any updated or 
upgraded version or new release provided by the Licensor or the Authorised 
Reseller (if applicable) under the terms of this License Agreement immediately 
on receipt of such version or release; 

(c) to use the Software Products only as described in the Documentation and 
subject to the restrictions as set out in clause 5 (License Restrictions above); 

(d) to reproduce and include the Licensor’s copyright notice (or such other party’s 
copyright notice as specified on the Software Products) on all and any copies 
of the Software Products, including any partial copies of the Software Products 
as permitted to be made under the terms of this License Agreement; 

(e) to hold all drawings, specifications, data (including object and source codes), 
Software Products listings and all other information relating to the Software 
Products confidential and not at any time, during this License or after its 



 

expiry, disclose the same, whether directly or indirectly, to any third party 
without the Licensor’s consent, and 

(f) to effect and maintain adequate security measures to safeguard the Software 
Product from access or use by any unauthorised person and indemnify the 
Licensor for losses flowing from your failure to do so. 

7. Intellectual Property Rights  

7.1 You acknowledge that all intellectual property rights in the Software Product and the 
Documentation throughout the world belong to the Licensor, that rights in the 
Software Product are licensed (not sold) to you, and that you have no rights in, or to, 
the Software Product or the Documentation other than the right to use them in 
accordance with the terms of this License Agreement. 

7.2 You acknowledge that you have no right to have access to the Software Product in 
source code form or in unlocked coding or with comments. 

7.3 The integrity of this Software Product is protected by technical protection measures 
(“TPM”) so that the intellectual property rights, including copyright, in the software 
of the Licensor are not misappropriated. You must not attempt in any way to remove 
or circumvent any such TPM, nor to apply, manufacture for sale, hire, import, 
distribute, sell, nor let, offer, advertise or expose for sale or hire, nor have in your 
possession for private or commercial purposes, any means whose sole intended 
purpose is to facilitate the unauthorised removal or circumvention of such TPM. 

8. Limited Warranty 

8.1 Subject to the limitations and exclusions of liability below and providing the 
Software is used in accordance with the Documentation and on an operating system 
or computer for which it was designed, the Licensor warrants that (a) the Media on 
which the Software Products is furnished will be free from material defects under 
normal use for a period of 90 days from the date of delivery (the “Warranty Period”); 
and that (b) during the Warranty Period, the Software Product will, when properly 
used, perform substantially in accordance with the functions described in the 
Documentation; and (c) that the Documentation correctly describes the operation of 
the Software Product in all material respects. 

8.2 If, within the Warranty Period, you notify the Licensor in writing of any defect or 
fault in the Software Product in consequence of which it fails to perform substantially 
in accordance with the Documentation, and such defect or fault does not result from 
you having amended the Software Product or used it in contravention of the terms of 
this License Agreement, the Licensor will, at its sole option, i) repair or replace the 
Software Product, provided that you make available all information that may be 



 

necessary to assist the Licensor in resolving the defect or fault, including sufficient 
information to enable the Licensor to recreate the defect or fault, or ii) terminate this 
License Agreement immediately by notice in writing to you and the Licensor will 
refund or if the Software Products have been purchased from an Authorised Reseller 
will procure that the Authorised Reseller shall refund; any of the fees paid as at the 
date of termination (less a reasonable sum in respect of your use of the Software 
Product to the date of termination) on return of the Software Product and all copies 
thereof. The Licensor’s obligation under this clause 8.2 is subject to your compliance 
with clause 6.1(b). 

8.3 You acknowledge that the Software Product has not been developed to meet your 
individual requirements and that it is therefore your responsibility to ensure that the 
facilities and functions of the Software Product as described in the Documentation 
meet your requirements. 

8.4 You acknowledge that the Software Product may not be free of bugs or errors and 
you agree that the existence of any minor errors shall not constitute a breach of this 
License Agreement. 

8.5 The Licensor shall not be liable under the said warranty above if the Software 
Product fails to operate in accordance with the said warranty as a result of any 
modification, variation or addition to the Software Products not performed by the 
Licensor or caused by any abuse, corruption or incorrect use of the Software 
Products, including use of the Software Products with equipment or other software 
which is incompatible. 

8.6 All other conditions, warranties or other terms which might have effect or be implied 
or incorporated into this License Agreement or any collateral contract, whether by 
statute, common law or otherwise, are hereby excluded, including, without limitation, 
the implied conditions, warranties or other terms as to satisfactory quality, fitness for 
purpose or the use of reasonable skill and care. 

9. Exclusion of Liability 

9.1 Nothing in this License Agreement shall limit or exclude the liability of either party 
for death or personal injury resulting from negligence, for fraud or for fraudulent 
misrepresentation. 



 

9.2 Subject to clause 9.1, the Licensor shall have no liability for any losses or damages 
which may be suffered by you (or any person claiming under or through you), 
whether the same are suffered directly or indirectly or are immediate or 
consequential, and whether the same arise in contract, tort (including negligence) or 
otherwise howsoever, which fall within any of the following: 

(a) loss of income; 

(b) loss of business profits or contracts; 

(c) business interruption; 

(d) loss of the use of money or anticipated savings; 

(e) loss of information; 

(f) loss of opportunity, goodwill or reputation; 

(g) loss of, damage to or corruption of data; or 

(h) any indirect or consequential loss or damage of any kind howsoever arising 
and whether caused by tort (including negligence), breach of contract or 
otherwise; 

provided that this clause 9.2 shall not prevent claims for loss of or damage to your 
tangible property that fall within the terms of clause 8 or a claim for a refund of the 
license fees paid to the Licensor or the Authorised Reseller (as applicable) for the 
license of the Software Products. 

9.3 Subject to clause 9.1 and clause 9.2, the Licensor's maximum aggregate liability 
under or in connection with this License Agreement, or any collateral contract, 
whether in contract, tort (including negligence) or otherwise, shall be limited to a 
sum equal to the fees paid by you to the Licensor or the Authorised Reseller (as 
applicable) for the license of the Software Products.  

9.4 Subject to clause 9.1, clause 9.2 and clause 9.3, the Licensor's liability for 
infringement of third party intellectual property rights shall be limited to breaches of 
third party rights subsisting in the UK and USA. 

9.5 This License Agreement sets out the full extent of the Licensor's obligations and 
liabilities in respect of the supply of the Software Products and Documentation.  In 
particular, there are no conditions, warranties, representations or other terms, express 
or implied, that are binding on the Licensor except as specifically stated in this 
License Agreement.  Any condition, warranty, representation or other term 
concerning the supply of the Software Products and Documentation which might 
otherwise be implied into, or incorporated in, this License Agreement, or any 



 

collateral contract, whether by statute, common law or otherwise, is hereby excluded 
to the fullest extent permitted by law. 

10. Term and Termination 

10.1 This License Agreement is effective for the period referred to clause 2.1 or until 
otherwise terminated in accordance with that clause. The Licensor may terminate this 
License Agreement immediately by written notice to you if: 

(a) save in respect of a Paid Up License, if you purchase the Software Products 
directly from the Licensor, you fail to pay any renewal or other fees due by you 
to the Licensor in respect of this License Agreement; 

(b) you fail to comply with any provisions of this License Agreement; 

(c) you commit a material or persistent breach of this License Agreement which 
you fail to remedy (if remediable) within 14 days after the service on you of 
written notice requiring you to do so; or 

(d) a petition for a bankruptcy order to be made against you has been presented to 
the court; or 

(e) where you, as the Corporate Licensee, become insolvent or unable to pay its 
(the company’s) debts, enters into liquidation, whether voluntary or 
compulsory (other than for reasons of bona fide amalgamation or 
reconstruction), passes a resolution for its winding-up, has a receiver or 
administrator manager, trustee, liquidator or similar officer appointed over the 
whole or any part of its assets, makes any composition or arrangement with its 
creditors or takes or suffers any similar action in consequence of its debt, or 
becomes unable to pay its debts or ceases to trade. 

10.2 In the event of termination in accordance with clause 10.1 you must immediately pay 
to the Licensor any sums due to the Licensor under the License Agreement and (at 
the Licensor’s sole option) you must return, destroy or delete all copies of the 
Software Products from all storage media in your control and, in the case of 
destruction, certify to us that you have done so. 

11. Export 

11.1 You will comply with all applicable laws, rules, and regulations governing export of 
goods and information, including the laws of the countries in which the Software 
Products was created. In particular, you will not export or re-export, directly or 
indirectly, separately or as a part of a system, the Software Products or other 
information relating thereto to any country for which an export license or other 
approval is required, without first obtaining such license or other approval. 



 

12. General 

12.1 You agree that the Licensor shall have the right, after supplying undertakings as to 
confidentiality, to audit any computer system on which the Software Products are 
installed in order to verify compliance with this License Agreement. 

12.2 You agree that the Licensor may use your company name in Licensor’s customer lists 
and other promotional materials describing your company as a customer or user of 
Licensor’s software or services, as applicable, unless it receives written notice from 
you objecting to such use. 

12.3 This License Agreement, its subject matter or its formation (including non-
contractual disputes or claims) shall be governed by and construed in accordance 
with English law and submitted to the non-exclusive jurisdiction of the English 
courts. 

12.4 This License Agreement constitutes the complete and exclusive statement of the 
agreement between the Licensor and you with respect to the subject matter of this 
License and supersedes all proposals, representations, understandings and prior 
agreements, whether oral or written, and all other communications between us 
relating to that subject matter except for those expressly referred to in this License 
Agreement. 

12.5 Any clause in this License Agreement that is found to be invalid or unenforceable 
shall be deemed deleted and the remainder of this License Agreement shall not be 
affected by that deletion. 

12.6 Failure or neglect by either party to exercise any of its rights or remedies under this 
License Agreement will not be construed as a waiver of that party’s rights nor in any 
way affect the validity of the whole or part of this License Agreement nor prejudice 
that party’s right to take subsequent action. 

12.7 This License Agreement is personal to you and you may not assign, transfer, sub-
contract or otherwise part with this License or any right or obligation under it without 
the Licensor’s prior written consent. 
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